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EXECUTIVE SUMMARY

Within the European Space Agency (ESA), the Climate Change Initiative (CCI) is a global monitoring
program which aims to provide long-term satellite-based products to serve the climate modelling and
climate user community. The two main products associated to the ECV Permafrost are Ground
Temperature (GT) and Active Layer Thickness (ALT). GT and ALT are documented by the
Permafrost_cci project based on thermal remote sensing and physical modelling.

The Permafrost cci models take advantage of additional datasets, such as snow cover and land cover,
to estimate the heat transfer between the surface and the underground. However, several challenges
remain due to spatially variable subsurface conditions, especially in relation to unknown amounts of
water/ice in the active layer that modify the effective heat capacity and the thermal conductivity of the
ground. In complex terrain with large spatial heterogeneities, coarse and partly inadequate land cover
categorisation, the current results show discrepancies with in-situ measurements, which highlight the
need to assimilate new data sources as model input. Although the ground stratigraphy is not directly
observable from space, it impacts the dynamics of the ground surface. The seasonal thawing and
refreezing induce cyclic subsidence and heave of the ground surface due to ice formation and melt in
the active layer, and can therefore be used as indirect indicator of the ground conditions.

Synthetic Aperture Radar Interferometry (InSAR) based on Sentinel-1 images can be used to measure
the amplitude and seasonal progression of these displacements. The movement amplitude is related to
the amount of water/ice that is affected by a phase change, whilst the timing of the displacement patterns
reflects the vertical progression of the thawing/freezing front. Considering the fine to medium spatial
resolution of Sentinel-1 images, InSAR time series therefore have the potential to enhance the
characterisation of subsurface hydrogeologic and thermal parameters and adapt the existing
Permafrost_cci models to improve their performance at the local to regional scale. The IcelnSAR pilot
project (Option 7) will develop a prototype for permafrost model adjustment by assimilating Sentinel-1
InSAR surface displacement maps and time series into the model to constrain stratigraphy parameters.
IcelnSAR will provide pilot products, expected to be used for adjustment of the ECV processing chain
of the baseline project in a next phase.

This Product Specification Document (PSD) describes the properties of the Svalbard study areas and
products that will be generated by the IcelnSAR Option 7, following the targeted user requirements
identified in URD for Option 7 (RD-1). The project considers the traditional Permafrost_cci products,
the ground temperature at a certain depth (GTD) and the active layer thickness (ALT), as well as an
additional product, the InSAR-based surface displacements (SD). For SD, this PSD defines two
products: the seasonal SD time series (SSD) and the multi-seasonal SD maps (MSD). For the traditional
Permafrost_cci parameters, this PSD considers the priorities established by the baseline project (RD-2),
while adjusting the specifications to the specific scope and objective of the Option 7. After assimilation
of InSAR-based SD in the model, we aim to deliver GTD and ALT at a higher spatio-temporal resolution
and an expected higher product accuracy. The final spatial coverage of the Option 7 pilot products is
however much smaller: at the local scale (at selected locations with available in-situ measurements) and
at the regional scale (flat lowlands in three study areas of Spitsbergen, Svalbard).
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1 INTRODUCTION

1.1 Purpose of the document

This document describes the product specifications in order to obtain a permafrost product that is
consistent, stable and error-characterised. The purpose of this document is to present the structure,
syntax and file naming conventions used to describe the different permafrost products generated in the
IcelnSAR Option 7. It provides all the necessary data needed by permafrost algorithm developers and
users to respectively write and read the permafrost products.

1.2 Structure of the document

Section 2 describes the area covered for the service as well as regions of interest for evaluation. The
remaining sections detail the product specifications (Section 3) and format (Section 4). A bibliography
complementing the applicable and reference documents (Sections 1.3 and 1.4) is provided in Section
5.1. A list of acronyms is provided in Section 5.2. A glossary of the commonly accepted permafrost
terminology can be found in [RD-9].

1.3 Applicable documents

[AD-1] ESA. 2022. Climate Change Initiative Extension (CCI+) Phase 2 — New Essential Climate
Variables — Statement of Work. ESA-EOP-SC-AMT-2021-27.

[AD-2] GCOS. 2022. The 2022 GCOS Implementation Plan. GCOS — 244 / GOOS — 272. Global
Observing Climate System (GCOS). World Meteorological Organization (WMO).

[AD-3] GCOS. 2022. The 2022 GCOS ECVs Requirements. GCOS — 245. Global Climate Observing
System (GCOS). World Meteorological Organization (WMO).

14 Reference Documents

[RD-1] Rouyet, L., Wendt, L., Westermann, S., Bartsch, A., Strozzi, T. 2023. ESA CCI+ Permafrost
Phase 2. CCN4 Option 7. IceInSAR: Inferred Active Layer Water/Ice Content and Freeze-Thaw
Progession From Assimilating InSAR in Permafrost Model. D.1.1 User Requirement Document (URD).
Version 1.0. European Space Agency.

[RD-2] Bartsch, A., Westermann, S., Strozzi, T., Wiesmann, A., Kroisleitner, C., Wieczorek, M., Heim,
B. 2023. ESA CCI+ Permafrost Phase 2. D1.2 Product Specification Document (PSD). Version 3.0.
European Space Agency.

[RD-3] Heim, B., Wieczorek, M., Pellet, C., Barboux, C., Delaloye, R., Bartsch, A., Strozzi, T. (2019):
ESA CCI+ Product validation and intercomparison report (PVIR), v1.0

[RD-4] Heim, B., Wieczorek, M., Pellet, C., Delaloye, R., Bartsch, A., Strozzi, T. (2020): ESA CCI+
D.4.1 Product validation and intercomparison report (PVIR), v2.0

[RD-5] Heim, B., Lisovski, S., Wieczorek, M., Pellet, C., Delaloye, R., Bartsch, A., Jakober, D., Pointer,
G., Strozzi, T. (2021): ESA CCI+ D.4.1 Product validation and intercomparison report (PVIR), v3.0
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[RD-6] Duchossois G., P. Strobl, V. Toumazou, S. Antunes, A. Bartsch, T. Diehl, F. Dinessen, P.
Eriksson, G. Garric, M-N. Houssais, M. Jindrova, J. Mufioz-Sabater, T. Nagler, O. Nordbeck. 2018.
User Requirements for a Copernicus Polar Mission - Phase 1 Report, EUR 29144 EN, Publications
Office of the European Union, Luxembourg, 2018, ISBN 978-92-79-80961-3,
https://doi.org/10.2760/22832, JRC111067.

[RD-7] National Research Council. 2014. Opportunities to Use Remote Sensing in Understanding
Permafrost and Related Ecological Characteristics: Report of a Workshop. Washington, DC: The
National Academies Press. https://doi.org/10.17226/18711.

[RD-8] Bartsch, A., G. Hugelius, Strozzi, T. 2021. ESA CCI+ Permafrost CCN3 Option 6: improved
soil description through a landcover map dedicated for the Arctic. User Requirements Document, v1.0.

[RD-9] van Everdingen, Robert, Ed. 1998 revised May 2005. Multi-language glossary of permafrost
and related ground-ice terms. Boulder, CO: National Snow and Ice Data Center/World Data Center for
Glaciology. (http://nsidc.org/fgdc/glossary/; accessed 23.09.2009).

1.5 Bibliography

A complete bibliographic list that supports arguments or statements made within the current document
is provided in Section 5.1.

1.6 Acronyms

A list of acronyms is provided in Section 5.2.
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2 KEY REGIONS FOR STUDY

The IcelnSAR Option 7 focuses on the flat lowlands within three study areas of Spitsbergen, Svalbard:
Adventdalen (ADV), Kapp Linné (KL) and Ny-Alesund (NYA) (Fig.1). Svalbard is characterized by a
polar-tundra climate (Peel et al., 2007) with permafrost at all elevations of the glacier-free areas. The
island of Spitsbergen experiences a large climatic gradient with higher temperature and greater
precipitation in the west influenced by mild oceanic currents, compared to the more continental interior
(Hanssen-Bauer et al., 2019). The seasonal and interannual meteorological variations, the variable
topography combining high mountains, large sediment-infilled valleys and strandflats, as well as the
diversity of the local environmental conditions lead to large spatio-temporal heterogeneities of the
ground thermal regime. The complex setting makes the region ideal to test the effect of constraining and
increasing the resolution of the Permafrost_cci products using InSAR-based surface displacements. In
addition, the global Permafrost cci products show a general bias towards high ground temperature and
thick active layer, expected to be related to the simplistic and coarse landcover categorization being
unable to represent the complexity of the ground properties in Svalbard (PVIR 1.0, 2.0 and 3.0 [RD-3]
[RD-4] [RD-5]). The attempt to use InSAR maps to enhance the characterization of subsurface
hydrogeologic and thermal parameters and improve the model performance at the regional scale is
therefore especially relevant for Svalbard.
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Figure 1: Study areas in Adventdalen (ADV), Kapp Linné (KAP) and Ny-Alesund (NYA). The IcelnSAR Option 7 focuses

on the flat lowlands within these areas (valley bottoms, strandflats). In the insets on the right: see examples of data coverage

from previously processed InSAR subsidence maps based on 2017 Sentinel-1 images. The black dots show the locations of
the main available permafrost monitoring boreholes (Christiansen et al., 2021). Modified from Rouyet et al. (2021).
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2.1 Adventdalen (ADV)

Adventdalen is a SE-NW oriented valley tributary to the Isfjord system. Longyearbyen, the main
Svalbard’s settlement is located in the western part of the study area (Fig.1). The Adventdalen (ADV)
study area has complex topography with mountain tops up to approx. 1050 m a.s.l. and valleys down to
the sea level, carved into sedimentary rocks (primarily sandstones and shales) (Major et al., 2001).
Following regional deglaciation, fluvial and periglacial processes have further developed the ADV
geomorphology. The valley flows are infilled by variably distributed fluvial, alluvial and eolian
sediments with contrasting properties, grain sizes and frost-susceptibilities (Tolgensbakk et al., 2001).
Ground ice distribution is also highly variable, with higher contents observed in the top few meters of
syngenetic permafrost, especially in eolian deposits, and at the top of underlying epigenetic permafrost
(Gilbert et al., 2018; Cable et al., 2018). In 2017-2019, the mean annual temperature at the permafrost
surface (upper-most sensor in the permafrost) varied between approx. -2 and -4 °C in the two main
Svalbard Integrated Observing System (SIOS) boreholes of the lower Adventdalen. The ALT was
approx. between 75 and 125 cm (Christiansen et al., 2021). The active layer generally thaws between
approx. June and September, although the duration of the thawing period varies from year to year.
Previous studies show that InSAR maps are well able to document the spatial variability of the seasonal
displacement amplitude, related with the distribution of various landform and surficial material types
(Rouyet et al., 2019), while InSAR subsidence-heave time series reflect the seasonal progression of the
thawing and freezing in the active layer (Rouyet et al., 2021).

2.2 Ny-Alesund (NYA)

The Ny-Alesund (NYA) study area is located along Kongfjorden in northwestern Spitsbergen and
includes a large research station converted from a former coal mining village (Fig.1). NYA is
characterized by a strandflat in the western part of the Braggerhalvegya peninsula and steep topography
with peaks at 790 m a,s,], in the southern part. The sedimentary bedrock is covered by a large variety of
terrestrial and coastal sediments (till, colluvial, fluvial and raised beach deposits) (Hjelle, 1999;
Miccadei, et al., 2016). Fine-scale variabilities of surface conditions (e.g. snow cover) and ground
properties have been reported in the well-studied Bayelva area and influence the way the air temperature
transfers into the ground (Boike et al., 2003; Westermann et al., 2010; 2011). At this location, a
permafrost research sites collects long-term environmental data since 1998 (Boike et al., 2018). In2017-
2019, the mean annual temperature at the permafrost surface (upper-most sensor in the permafrost)
varied between approx. -2.5 and -3.5 °C in the two main boreholes of the Svalbard Integrated Observing
System (SIOS). The ALT was approx. between 150 and 200 cm (Christiansen et al., 2021). Previous
analyses of InSAR-based displacement time series from active layer seasonal freeze and thaw
progression have also been performed in the NYA study area (Rouyet et al., 2021).

2.2 Kapp Linné (KL)

The Kapp Linné (KL) study area is located in the westernmost part of the Nordenskidld peninsula
(Fig.1). Influenced by the North Atlantic maritime regime, this is one of the warmest parts of Spitsbergen
(Retelle et al., 2020). The Isfjord Radio weather station, used as research facility for field operations, is
situated in the northwestern part, close to the shore. The area is characterized by a low-lying Precambrian
bedrock platform — the strandflat — mantled by raised beach deposits (Landvik et al., 1987). The
strandflat consists of a complex assemblage of dry, coarse-grained, raised marine beach ridges and
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exposed weathered bedrock, interspersed with thermokarst lakes, organic-rich shallow bogs with a large
variety of permafrost landforms (small palsas, ice-wedge polygons, sorted/unsorted circles) (Akerman,
2005; Eckerstorfer et al., 2017). Further west, the Griegfjellet ridgeline leads to a dramatic change of
topography, with peaks reaching up to approx. 780 m a.s.l. Close to Isfjord Radio, permafrost
observations have been carried out since 2008 (Christiansen et al., 2010). In 2017-2019, the mean
annual temperature at the permafrost surface (upper-most sensor in the permafrost) varied between
approx. -1.5 and -2.5 °C in the two main boreholes of the Svalbard Integrated Observing System (SIOS).
The ALT was approx. between 175 and 300 cm (Christiansen et al., 2021). Analyses of InSAR-based
displacement time series from active layer seasonal freeze and thaw progression have also been
performed in the KL study area (Rouyet et al., 2021).
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3 PRODUCTS SPECIFICATIONS

3.1 Surface displacement (SD)

3.1.1  Product description

This product consists of maps and time series documenting the distribution and seasonal progression of
the freeze/thaw-related surface displacements (SD) based on Sentinel-1 Synthetic Aperture Radar
Interferometry (InSAR). Sloping terrain will be discarded to focus on flat lowlands assumed to be
dominated by vertical SD (i.e. strandflats and sediment-infilled valley bottoms). Initial line-of-sight
(LOS) SD will therefore be projected vertically. We will provide two types of complementary SD
products to test the INSAR assimilation into the Permafrost _cci model:

e  Seasonal SD time series (SSD): Image pairs (interferograms) will be generated within snow-free
seasons (May—June to October—November) in 2017-2021 based on Sentinel-1 Interferometric
Wide (IW) swath images with a time interval (temporal baseline) depending on the coherence
variability during the observation window. To minimise the processing steps required for product
generation before assimilation in the model, we will test the feasibility of using single wrapped
(cyclic phase) and unwrapped (absolute phase) interferograms as model inputs. However, single
interferograms are expected to have a low signal-to-noise ratio due to the impact of unwanted phase
components, such as the Atmospheric Phase Screen (APS) (Hanssen, 2001). We will therefore also
process the 2017-2021 seasonal SD time series with the multi-temporal Small BAseline Subset
(SBAS) algorithm (Berardino et al., 2002), which uses the redundancy of overlapping
interferograms to mitigate the atmospheric component. Previous work has evidenced that SBAS
time series can document fine temporal variability of subsidence and heave patterns, able to reflect
the seasonal progression of thawing and freezing front in the active layer (Rouyet et al., 2019). The
time series can be used to identify late-summer secondary subsidence patterns highlighting
degradation of ice-rich layers at the top of the permafrost (Bartsch et al. 2019, Zwieback & Meyer,
2021). Based on the SBAS time series, we will generate SD maps showing the maximal
displacement of each snow-free season. These maps are used to document the spatio-temporal
variability of the active layer water/ice content for each season.

e  Multi-seasonal SD maps (MSD): The multi-seasonal product is an averaged SD map discarding
information regarding the inter-seasonal variability of the signal to focus on the spatial patterns
only. The SD amplitude in permafrost environment is highly related to the frost-susceptibility of
the ground material, i.e. the ability for water to turn into ice lenses and lift up the ground surface
during the freezing period. As frost-susceptibility depends on the material grain size, there is a
relationship between the seasonal movement amplitude and the landcover type (Bartsch et al.,
2019) or geomorphological units (Rouyet et al., 2019), which will be used to generate InNSAR-based
geocryological maps to constrain the parametrization of the ground stratigraphy in the model.

The products will be generated for the three study areas (ADV, NYA and KL) described in Section 2.

3.1.2  Temporal resolution

The temporal resolution of the SD time series will correspond to the repeat-pass of Sentinel-1, i.e. 6-
days for the seasons when both Sentinel-1A and -1B images were available (2017-2021). Due to
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coherence loss during the winter, this applies to the snow-free periods only, which have variable
durations depending on the year and the study area (typically May—June to October—November in
Svalbard).

3.1.3  Spatial resolution

The initial resolution of Sentinel-1 IW images is approx. 5 m in range and 20 m in azimuth. Complex
spatial averaging (multi-looking) improves the signal stability and dampens the influence of
unrepresentative scattering effects within resolution cells. We will evaluate these effects by testing
different InNSAR multi-looking factors, which will lead to a final ground resolution between 40—100 m.
It should also be noted that the InSAR information will be spatially discontinuous. Areas affected by
typical SAR geometrical limitations (shadow/layover) and interferometric coherence loss due to
wet/snow-covered surfaces or fast displacements (> Y4 the wavelength during the time interval of the
interferograms, i.e. about 1.4 cm in 6 days) will remain undocumented.

3.1.4  Product accuracy

For SD, the JRC report on User Requirements for a Copernicus Polar Mission [RD-6] requires a vertical
accuracy of 0.001 m/yr (goal) to 0.01 m/yr (threshold) (see URq 20 in the URD [RD-1]).

In the IcelnSAR Option 7, despite the relatively short temporal baseline (intra-seasonal) and the short
time observation window of the SBAS (approx. 0.5 year), the accuracy is estimated to be above the
threshold requirement (0.01 m/yr). This is due to the small extent of the study areas (i.e. short distances
to the reference point), as well as the frequent repeat-pass of Sentinel-1 resulting in a large number of
interferograms (see Eq. 19, Emardson et al., 2003). The standard deviation of the retrieved velocity
depends on the number of interferograms (60—100 per season) and the temporal baseline (6—48d
depending on the time period). Assuming a standard deviation of 5 mm per interferogram due to the
atmosphere, the standard deviation is estimated to go down to a few mm (1-3 mm) for seasons with 6-
days repeat-pass (2017-2021) (see Eq. 11, Emardson et al., 2003).

Considering the scarcity of SD in-situ data in Svalbard, it is generally a challenge to quantify the
accuracy of the products. For the similar observation periods and acquisition times, the interferometric
coherence time series will be documented. As an estimate of the phase standard deviation, coherence
values give a relative measure of stability/certainty (Balmer & Hartl, 1998) that can be used to weight
the measurements in the model.

3.1.5  Product attributes
SD products Unit Property Values provided Product string
Seasonal SD time mm / SBAS-based Displacement SSD
series unitless | displacement time progression relative to
series (2017-2021) first seasonal
acquisition, /
coherence time series
Multi-seasonal SD mm Averaged maximal Mean, median and MSD
maps displacement of the standard deviation of
seasons (2017-2021) | the maximal seasonal

PAGE 11




CCN4 CCI+ Permafrost Phase 2 Issue 1.0

D.1.2 Product Specification Document Option 7 IcelnSAR 31 Mars 2023
displacement (2017—
2021), averaged
coherence

3.1.6  Data documentation and dissemination

The datasets will be published on PANGAEA (targeting permafrost community) at the end of the project
(Q4 2024).

3.2 Ground temperature at a certain depth (GTD) and active layer thickness (ALT)

3.2.1  Product description

This product includes the ECV state variables ground temperature and active layer thickness derived
from a thermal model driven by land surface temperature data. The ground temperature at a certain depth
(maximum 5 m) (GTD) and the active layer thickness (ALT) will be provided at two spatial scales:

e Proof-of-concept products at the local scale: One-dimensional point-scale simulations will be
performed at selected locations with available land surface temperature (LST) measurements from
in-situ instrumentation. The results will be directly comparable with GTD and ALT from
permafrost monitoring in boreholes. The model will be run before and after assimilation of the
InSAR SD products to compare the performance.

o Experimental products at the regional scale: For the flat lowlands of the ADV, NYA and KL
study areas (see Section 2), the model will be driven by ERA-5 reanalysis data. The model will be
run before and after the assimilation of InSAR SD products. While the initial Permafrost cci
product has a 1 km resolution, the results after the SD assimilations will be at the higher resolution
of the InSAR SD products (40-100 m) (see Section 3.1).

Considering the period for which we will process the SD products (see Section 3.1), we will essentially
focus on the similar years (2017-2021) for testing the assimilation procedure and generating GTD and
ALT. The model spin-up largely follows the accelerated spin-up procedure described in the Section
3.1.4 of Westermann et al. (2022). Subsurface properties constrained by assimilation of the SD products
are also expected to lead to an improved performance in the earlier years.

3.2.2  Temporal resolution

e At the local scale (one-dimensional point-scale simulations), the products will have a daily
resolution.

e At the regional scale (ADV, NYA and KL study areas, see Section 2), we will provide products
with one-year temporal resolution, which corresponds to average mean annual ground temperature,
as well as the maximum depth of seasonal thaw, which corresponds to the active layer thickness.

3.2.3  Spatial resolution

The spatial resolution of the initial Permafrost cci products is linked to the best available resolution of
the input sensor. Here, the spatial resolution is limited to 1 km, which is the spatial resolution of remotely
sensed LST. However, an ensemble-based modelling of subpixel variability is applied, i.e. different
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ensemble members represent different ground stratigraphies and snow depths found within the 1 km
pixels. This is required for computation of permafrost and talik fractions. Considering the specific
objective of assimilating InSAR products within the model, the regional GTD and ALT products of the
IceInSAR Option 7 will be downscaled based on the higher resolution InSAR-based SD products. The
variability of the results within a 1 km grid of the initial Permafrost cci products (and the resulting
computed permafrost and talik fractions) will be compared with the results from the representation of
subpixel variability based on ensemble-based modelling.

3.2.4  Product properties

ECV variable Unit Property Values provided | Product string
Ground degree C At the local scale: daily Results before GTD
temperature at modelled temperature and after

certain depth InSAR-based

At the regional scale:

(maximum 5 m) SD assimilation.

annual average

Active layer m At the local scale: daily At the regional | ALT
thickness thaw depth scale:
Median and

At the regional scale:

. standard
annual maximum thaw

depth deviation of the

ensemble

3.1.5  Product accuracy

With respect to the threshold user requirements documented in the URD [RD-1], the following accuracy
is targeted in year 2/3 of phase 1:

e  Ground temperature: 2.0 degrees C compared to GTN-P boreholes (URq 12).

e Active layer thickness: RMSE < 0.25 m for ALT < 1.0 m and RMSE < 0.5 m for ALT > 1.0 m
(URq_13).

Product accuracy of the years 1 and 2 of the Permafrost_cci Phase 1 products are documented in the
PVIR [RD-3] [RD-4]. The accuracy of the CRDP v3 (phase 1, year 3) [RD-5] demonstrates for Mean
Annual Ground Temperature (MAGT) time series from 1997 to 2019 across all depths an absolute bias
of 1.58 °C, a mean bias of 0.98 °C and an RMSE of 1.93 °C for the whole range of validation data.
Considering only permafrost measurement borehole sites with an MAGT < 1 °C, we get an absolute
bias of 1.46 °C, a mean bias of -0.01 °C and an RMSE of 1.87 °C. Active layer thickness of the CRDP
v3 (phase 1, year 3) is characterized by an absolute bias of 30 cm, a mean bias of -1.08 cm and an RMSE
of 47 cm, when calculated for the bulk dataset. Results in Svalbard displays a positive bias attributed to
the unrealistic landcover categorisation of this region. As a contribution to refine the documentation of
the ground stratigraphy, InSAR-based SD products are expected to improve the modelled results in
Svalbard.

3.1.6  Data exploitation and dissemination

The results will provide new findings valuable for the discussion of the Permafrost_cci data quality and
will be used in the Product Validation and Intercomparison Report (PVIR) of the Phase 2.
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The datasets will be published on PANGAEA () at the end of the project (Q4 2024).
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4 PRODUCT FORMATS
4.1 Surface displacement (SD)

4.1.1 Product projection system

The Coordinate Reference System (CRS) used for the IceInSAR Option 7 in Svalbard will be projected
in Transverse Mercator UTM 33N based on the World Geodetic System 1984 (WGS 1984) reference
ellipsoid. The coordinates are specified in meters. Information on product projection, ellipsoid and pixel
size will be included in the NetCDF.

4.1.2  File formats

All datasets are provided in NetCDF format.

4.1.3  Product file naming conventions
The files for each product type are named as follows:

ESACCI-<CCI  Project>-<Processing  Level>-<Data  Type>-<Product  String>[-<Additional
Segregator>]-<Start Date>-<End Date>-fv<File version>.nc

<CCI Project>
PERMAFROST for permafrost_cci

<Processing Level>
L3 for Level 3 (SSD).

L4 for Level 4 (MSD)

<Data Type>
SSD: Seasonal surface displacement time series.
MSD: Multi-seasonal surface displacement maps.

<Product String>

This should be structured as: <Source>_ <Algorithm>:
<Source>: SENTINEL-1: SAR images from Sentinel-1.
<Algorithm>: INSAR: Products processed with an INSAR algorithm.

<Additional Segregator>

This should be structured as: AREA<Area number>_<Subarea name>_<Layer type >
<Area number>: 9 for Nordenskiold Land (Svalbard).
<Subarea name>: ADV, NYA or KL.
<Layer type >: DISP or COH

<Start Date> and <End Date>

The identifying dates for the dataset:

Format is YYYYMMDD, where YYYY is the four-digit year, MM is the two-digit month from 01 to
12 and DD is the two-digit day of the month from 01 to 31. Annual or multi-annual products are
represented with YYY'Y only.
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fv<File Version>

File version number in the form n{1,}[.n{1,}] (two digits followed by a point and one or more digits).

Examples:

ESACCI-PERMAFROST-L3-SSD-SENTINEL1 INSAR-AREA9 NYA DISP-2019-fv01.0.nc

4.1.4 File metadata

The following attributes are included in the NetCDF file:

title
institution

source
history

references
tracking_id

Conventions
product_version

summary

keywords
id

naming authority

keywords_vocabulary

cdm_data_type

comment

date_created
creator_name
creator_url

project
geospatial_lat_min
geospatial lat_max
geospatial_lon_min

geospatial_lon_max

geospatial_vertical _min

ESA CCI permafrost <parameter name>

NORCE Norwegian Research Centre

<text>
YYYY-MM-DD HH:MM:SS

http://cci.esa.int/Permafrost [and publications]
<XXXXXXXX-YYYY-ZZZZ-nnnn-mmmmmmmmmmmm> a UUID
(Universal Unique Identifier) value

CF-1.9
<number>

<text>
<text>
<filename>

no.norce

NASA Global Change Master Directory (GCMD) Science
Keywords

Grid

These data were produced at ESACCI as part of the ESA
Permafrost CCI+ project Contract No 4000123681/18/I-NB

<file creation date>

NORCE Norwegian Research Centre
https://www.norceresearch.no

Climate Change Initiative - European Space Agency
30

90

-180

180

0.0
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geospatial_vertical max 0.0
time_coverage_start YYYYMMDDTHHMMSSZ
time_coverage end YYYYMMDDTHHMMSSZ

time_coverage_duration
time coverage resolution
standard_name_vocabulary
license

platform
spatial_resolution
geospatial_lat_units
geospatial_lon_units
geospatial_lon_resolution
geospatial_lat_resolution
key_variables

format_version

P<number of years>Y
P<number><unit>

CF Standard Name Table v73
ESA CCI Data Policy: free and open access
<name>

<number><

none

none

<number><

<number><

<name>

CCI Data Standards v2.2

4.2 Ground temperature at a certain depth (GTD) and active layer thickness (ALT)

4.2.1

Product projection system

The Coordinate Reference System (CRS) used for the IceInSAR Option 7 in Svalbard will be projected
in Transverse Mercator UTM 33N based on the World Geodetic System 1984 (WGS 1984) reference
ellipsoid. The coordinates are specified in meters. Information on product projection, ellipsoid and pixel
size will be included in the NetCDF.

4.2.2  File formats

All datasets are provided in NetCDF format.

4.2.3  Product file naming conventions
The files for each product type are named as follows:

ESACCI-<CCI  Project>-<Processing  Level>-<Data
Segregator>]-<Start Date>-<End Date>-fv<File version>.nc

Type>-<Product  String>[-<Additional

<CCI Project>
PERMAFROST for permafrost_cci

<Processing Level>
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L4 for Level 4.

<Data Type>
GTD: ground temperature at a certain depth. ALT: active layer thickness.

<Product String>

This should be structured as: <Source>_ <Algorithm>:
<Source>: MODIS: Land surface temperature from the Moderate Resolution Imaging
Spectroradiometer instrument. INSITU: Land surface temperature from in-situ loggers.
<Algorithm>: CRYOGRID: Products processed with a CRYOGRID algorithm.

<Additional Segregator>
This should be structured as: AREA<Area number> <Subarea name> <Layer type> <Model
constrain>
<Area number>: 9 for Nordenskiold Land (Svalbard).
<Subarea name>: ADV, NYA or KL.
<Layer type>: PP: permafrost parameter regional products. PT: permafrost parameter point-scale
products (one-dimensional simulations).
<Model constrain>: INIT: initial model (before InSAR assimilation). CONS: SD-constrained
model (after INSAR assimilation).

<Start Date> and <End Date>

The identifying dates for the dataset:

Format is YYYYMMDD, where YYYY is the four-digit year, MM is the two-digit month from 01 to
12 and DD is the two-digit day of the month from 01 to 31. Annual or multi-annual products are
represented with YYYY only.

fv<File Version>
File version number in the form n{1,}[.n{1,}] (two digits followed by a point and one or more digits).

Examples:
ESACCI-PERMAFROST-L4-GTD-MODIS CRYOGRID-AREA9 ADV PT CONS-2017-fv01.0.nc

4.1.4 File meta data - NetCDF

The following attributes are included in the NetCDF file:

title ESA CCI permafrost <parameter name>

institution University of Oslo

source <text>

history YYYY-MM-DD HH:MM:SS

references http://cci.esa.int/Permafrost [and publications]

tracking_id <XXXXXXXX-YYYY-ZZZZ-nnnn-mmmmmmmmmmmm> a UUID

(Universal Unique Identifier) value

Conventions CF-1.9

product_version <number>
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keywords_vocabulary

cdm_data_type

comment

date_created
creator_name
creator_url

project
geospatial_lat_min
geospatial lat_max
geospatial_lon_min
geospatial _lon_max
geospatial_vertical_min
geospatial_vertical max
time_coverage_start

time coverage end
time_coverage_duration
time coverage resolution
standard_name_vocabulary
license

platform
spatial_resolution
geospatial_lat_units
geospatial_lon_units
geospatial_lon_resolution

geospatial_lat_resolution
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summary <text>
keywords <text>
id <filename>
naming authority no.uio

NASA Global Change Master Directory (GCMD) Science
Keywords

Grid

These data were produced at ESACCI as part of the ESA
Permafrost CCI+ project Contract No 4000123681/18/I-NB

<file creation date>
University of Oslo
https://www.uio.no/english
Climate Change Initiative - European Space Agency
30

90

-180

180

0.0

0.0
YYYYMMDDTHHMMSSZ
YYYYMMDDTHHMMSSZ
P<number of years>Y
P<number><unit>

CF Standard Name Table v73
ESA CCI Data Policy: free and open access
<name>

<number><

none

none

<number><

<number><
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Global Attribute Content
key_variables <name>
format_version CCI Data Standards v2.2
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5.2 Acronyms

AD Applicable Document

ADV Adventdalen

ALT Active Layer Thickness

APS Atmospheric Phase Screen

B.GEOS B.Geos GmbH

CCI Climate Change Initiative

CRDP Climate Research Data Package

CRS Coordinate Reference System

ECV Essential Climate Variable

EO Earth Observation

ESA European Space Agency

GAMMA Gamma Remote Sensing AG

GCOS Global Climate Observing System

GT Ground Temperature

GTD Ground Temperature at certain depth
GTN-P Global Terrestrial Network for Permafrost
InSAR Synthetic Aperture Radar Interferometry
IPA International Permafrost Association
IPCC Intergovernmental Panel on Climate Change
Iw Interferometric Wide

KL Kapp Linné

LOS Line-of-sight

LST Land Surface Temperature

MAGT Mean Annual Ground Temperature
MAGST Mean Annual Ground Surface Temperature
MSD Multi-seasonal Surface Displacement
NetCDF Network Common Data Format

NORCE Norwegian Research Centre

NYA Ny-Alesund

PFR Permafrost extent (Fraction)

PFF Permafrost-Free Fraction

PFT Permafrost underlain by Talik

PVIR Product Validation and Intercomparison Report
PSD Product Specification Document
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PSTG Polar Space Task Group

PZ0O Permafrost Zone

RD Reference Document

RMSE Root Mean Square Error

RS Remote Sensing

SBAS Small Baseline Subset

SAR Synthetic Aperture Radar

SD Surface Displacement

SSD Seasonal Surface Displacement
SSI Single Seasonal Interferograms
TSP Thermal State of Permafrost
UIO University of Oslo

URD Users Requirement Document
URq User Requirement

WGS 84 World Geodetic System 1984
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